
Modeliranje u programskom alatu Blender

Ljubojević, Dario

Undergraduate thesis / Završni rad

2020

Degree Grantor / Ustanova koja je dodijelila akademski / stručni stupanj: University of 
Zagreb, Faculty of Organization and Informatics / Sveučilište u Zagrebu, Fakultet 
organizacije i informatike

Permanent link / Trajna poveznica: https://urn.nsk.hr/urn:nbn:hr:211:440320

Rights / Prava: Attribution-NonCommercial-NoDerivs 3.0 Unported / Imenovanje-Nekomercijalno-Bez 
prerada 3.0

Download date / Datum preuzimanja: 2024-04-20

Repository / Repozitorij:

Faculty of Organization and Informatics - Digital 
Repository

https://urn.nsk.hr/urn:nbn:hr:211:440320
http://creativecommons.org/licenses/by-nc-nd/3.0/
http://creativecommons.org/licenses/by-nc-nd/3.0/
http://creativecommons.org/licenses/by-nc-nd/3.0/
https://repozitorij.foi.unizg.hr
https://repozitorij.foi.unizg.hr
https://zir.nsk.hr/islandora/object/foi:5939
https://repozitorij.unizg.hr/islandora/object/foi:5939
https://dabar.srce.hr/islandora/object/foi:5939


 

SVEUČILIŠTE U ZAGREBU 

FAKULTET ORGANIZACIJE I INFORMATIKE 

V A R A Ž D I N 

 

 

Dario Ljubojević 

 

 

 

MODELIRANJE U PROGRAMSKOM 

ALATU BLENDER 

ZAVRŠNI RAD 

 

 

 

 

 

  

 

 

 

 

 

 

Sisak, 2020. 



 

SVEUČILIŠTE U ZAGREBU 

FAKULTET ORGANIZACIJE I INFORMATIKE 

V A R A Ž D I N 

 

 

Dario Ljubojević 

Studij: Primjena informacijske tehnologije u poslovanju  

 

 

 

 

MODELIRANJE U PROGRAMSKOM 

ALATU BLENDER 

ZAVRŠNI RAD 

 

 

 

 

   Mentor:     Doc.dr.sc Robert Kudelić 

 

                                                                              

 

 

 

 

 

Sisak, rujan 2020. 
 



 

Izjava o izvornosti  
 

Izjavljujem da je završni rad izvorni rezultat mojeg rada te da se u izradi istoga nisam koristio 

drugim izvorima osim onima koji su u njemu navedeni. Za izradu rada su korištene etički 

prikladne i prihvatljive metode i tehnike rada.  

 

 

 

Autor 

Dario Ljubojević 

 

 

  



 

Sažetak 

Tema završnog rada je „Modeliranje u programskom alatu Blender“, a odnosi se na 

izradu 3D modela Utvrde Starog grada Siska u svom okruženju. Smjer rada je da se prikažu 

jednostavne metode 3D modeliranja te da se prikaže kako se može jedna kompleksna scena 

kreirati pomoću jednostavnih geometrijskih oblika. 

Ključne riječi: Blender; geometrijski oblici; jednostavni model; 3D, tekstura, 
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1. Uvod 

Veliki i brzi razvoj industrije video igara veliki je poticaj i motivacija za sve generacije 

i za sve one koji vide priliku u razvoju profesionalne karijere u tom smjeru. Također, sami naziv 

teme „Modeliranje u programskom alatu Blender“ na prvi pogled mi se činilo kao jako 

zanimljiva tema, s obzirom da sam imao određenog iskustva u programskom alatu Blender, kao 

i u općenitom smislu 3D modeliranja. Ideja koja stoji iza izbora ove tebe bila je da svoje 

osnovno znanje zaokružim u određenu cjelinu, te da ih nadogradim određenim pojmovima koje 

mogu pronaći na internetu. Dodatno, ideja je da ostanem u okvirima jednostavnosti te da ovaj 

završni rad bude odličan primjer za početnike i one koji se tek upoznaju sa ovim programskim 

alatom.  

Sadržaj ovog završnog rada biti će da se u početku opišu neke najosnovnije značajke 

programskog alata Blender, osnovne tehnike modeliranja, te da se definiraju neke početne 

postavke pri početku izrade 3D modela. Prvobitna ideja je bila da se uz 3D modeliranje izradi 

i određena animacija, nažalost zbog neočekivano slabih performansi računala, taj proces bi bio 

moguć, ali jako dugotrajan i naporan za samo računalo. Stoga, glavna ideja je da se modelira 

Utvrda Starog Grada Siska, jednostavnim metodama modeliranja koristeći jednostavne 

geometrijske oblike. Prilikom modeliranja prikazat će se izrada nekoliko glavnih elemenata 

poput: Utvrde, zemljanog terena, vodene površine, te ubacivanja drugih 3D modela u naš 

zasebni model. Za kraj, izrađeni 3D model uvesti ću u programski alat „Unity“ koji služi za 

razvoj video igara. 

Kroz samo pisanje rada, svoje opisivanje postupka izrade 3D modela potkrijepiti ću sa 

slikama kako bih što kvalitetnije prikazao samo modeliranje te kako bih efektivno prikazao 

kronološki slijed izrade modela. Na samome kraju, prikazat ću završni generirani izgled svoga 

rada, sa svim zasebnim elementima prethodno navedenim, opisanim i prikazanim u radu.  
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2. Uvod u programski alat Blender 

2.1. Općenito o programskom alatu Blender 

Programski alat Blender je besplatni program koji nam služi za kreiranje različitih 3D 

modela, animacija, tekstura, vizualnih efekata, videoigara i slično. Povijest Blendera seže u, 

sada već, daleku 1993. godinu kada se kreira prva verzija softvera sa tek nekoliko zanimljivih 

opcija. Nakon burnih 10tak godina, konačno 2005. godine Blender postaje potpuno besplatan 

za svoje korisnike i tek tada počinje njegovo masovno korištenje. Specifikacija Blendera je vrlo 

jednostavna i ne zahtjevna. Podržava rad na svim popularnijim operativnim sustavima poput 

GNU/Linux, Mac OS i Windows. Odlike Blendera su njegova jednostavnom, te mala veličina 

instalacije čija veličina je u starijim verzijama bila do 40MB. Upravo zbog takve male 

instalacije, najveća odlika Blendera je što posjeduje sve odlične karakteristike vrhunskog 

softvera za 3D modeliranje.  

Neke od karakteristika su:  

- Odlična podrška za gotovo sve geometrijske oblike, kao i mrežne poligone te 

površinsko modeliranje 

- Kontrola u realnom vremenu za vrijeme simulacije i renderiranja 

- Kreiranje igara u realnom vremenu 

- Kreiranje krivih linija na bazi deformacija 

- Mrežasta detekcija sudara i mnoge druge 

„Blender je prepun korisnih alata, ali neki će biti važniji za početnike od drugih. Mnogima koji 

dolaze u Blender najpopularniji alati su modeliranje, kiparstvo i teksturiranje, kao i animacija. 

Oni koji stvaraju predmete za 3D ispis možda neće ići dalje od modeliranja i kiparstva.“ 

(Hartmann, 21.5.2020.) 

 Kada govorimo o sistemskim zahtjevima, za razliku od ostalih programa za 3D 

modeliranje, Blender ima relativno visoke zahtjeve. Stoga, minimalni sistemski zahtjevi su: 

Procesor 1 GHz, 512 RAM memorije, grafička kartica sa 54MB RAM-a, te najmanji monitor 

od 1024x768 piksela. Proizvođači preporučuju, za donekle zahtjevniji rad, minimalno od 2 GHz 
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dvojezgreni procesor, 2 GB RAM memorije, grafičku karticu sa 512 MB RAM-a, te visoko 

rezolucijski monitor sa 1920x1200 piksela i 24-bitnim prikazom boja.  

 Prva ideja završnog rada uključivala je tvrđavu Stari grad Sisak, ali je također i 

uključivala i izradu animacije ili animirane šetnje prema utvrdi ili kroz utvrdu. Nažalost, upravo 

zbog dosta velikih očekivanih performansi računala, takva ideja nije mogla zaživjeti stoga sam 

se pridržavao svojih mogućnosti te sam izradio jednostavnu statičku scenu 3D modela utvrde. 

Sam postupak modeliranja obuhvaćao je najjednostavnije metode. Pridržavao sam se ideje da 

pokušam relativno kompleksnu 3D scenu kreirati pomoću jednostavnih geometrijskih oblika, 

te da ne koristim specijalne efekte, niti kompleksne postavke i opcije.  

2.2. Osnovne tehnike modeliranja 

U programskom alatu Blender postoji nekoliko tehnika oblikovanja sa kojima možemo 

stvarati nove 3D ili 2D modele. Tehnike se razlikuju same po sebi, a koriste se zasebno ili u 

kombinaciji sve ovisno o vrsti modela, našim željama, preferencijama i slično. Blender sadrži 

5 osnovnih tehnika, a to su: Objektno modeliranje (Mesh modeling), Oblikovanje (Sculpting), 

Modeliranje krivuljama (Curve modeling), Proceduralno modeliranje (Procedural modeling) i 

Simulacije (Simulation).  

Objektno modeliranje (Mesh modeling) je najosnovnija tehnika modeliranja. Koriste 

se jednostavni 3D geometrijski oblici, te moguće je na istima primjenjivati jednostavne 

operacije poput Kopiraj (Duplicate), Pomakni (Move), Istisni (Extrude) i slično.  

Oblikovanje (Sculpting) je način izrade 3D modela pomoćnu raznih alata kojima se 

mijenja struktura i izgled objekta. Za oblikovanje, potrebno je koristiti kistove sa kojima 

Blender raspolaže u velikom broju, a svaki kist ima svoj oblik i određene opcije kao što su 

radijus i jačina manipulacije (Strength).  

Modeliranje krivuljama (Curve modeling) je slabo korištena tehnika koja koristi 

krivulje kako bi se kreirao određeni izgled nekog modela i to na način da se kreira određena 

površina između dvije krivulje.  

Proceduralno modeliranje (Procedural modeling) je napredna tehnika modeliranja 

koja uključuje poznavanje programskih jezika i posebnih metoda modeliranja pomoću čvorova 

(Node based modeling) kako bi se moglo manipulirati raznim geometrijama.  
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Simulacije (Simulation) su tehnika dinamičnog modeliranja koja uključuju već 

postojeće grafičke prikaze nekih elemenata na kojima se mogu podešavati razne opcije poput 

jačine, snage, veličine i slično. Ti grafički prikazi odnose se na simulacije toka vode ili vjetra, 

kao i modeliranje vatre ili prikaz dima. Kretanje i sama dinamika elemenata veliki su aspekt u 

izradi računalnih igara, stoga su simulacije jedne od jako bitnih tehnika modeliranja.  

 

3. Gruba izrada modela Starog grada i terena 

Nakon završetka svih početnih priprema scene i postavljanja početnih konfiguracija 

krenuo sam u izradu glavnog elementa završnog rada – kule Starog grada Siska. Za razliku od 

većine primjera koje sam mogao pronaći prilikom istraživanja, početni oblik kocke sam 

iskoristio kao prvi i osnovni element za početak izrade. Osnovnim dupliciranjem objekata i 

namještanjem kreirao sam repliku sjevernog zida kule koji je kao takav srednje kompliciran za 

izradu s obzirom da na njemu postoji otvor za dvorišna vrata. Zid sam kreirao na 3 zasebna 

segmenta koji će mi pomoći kasnije prilikom završne izrade modela Starog grada.  

 

Slika 1. Kreiranje početnog zida 

 

Nakon zadovoljavajućeg grubog izgleda sjevernog zida kule Starog grada započeo 

sam grubu izradu istočne kule s kojom ću se nadovezati na spomenuti zid. Kula je kreirana 

pomoću naredbe Stvori -> Cilindar (Create -> Cylinder) , te postavljena u približnu veličinu s 

obzirom na zid. Samu točnu poziciju i veličinu objekta kule postavio sam naknadno, koristeći 

razne kute gledanja kako bih precizno postavio kulu na mjesto bez jako vidljivih preklapanja. 
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Slika 2. Kreiranje početne kule i  zida 

 

Prethodna izrada zida u segmente omogućila mi je da jednostavnije dupliciram potrebne 

segmente na preostala dva zida. Naime, prema oglednoj slici koju sam koristio za primjer, 

sjeverni zid ima dodatno otvor za vrata, dok gornji segmenti zida su identični na sva tri. Prije 

samog dupliciranja, tek izrađeni zid sam centrirao i pričvrstio za već postojeću kulu. Svaki 

segment zasebno sam učvrstio na istu točku pomoću naredbe Objekt -> Postavi ishodište -> 

Ishodište na 3D pokazivaču (Object -> Set Origin -> Origin to 3D Cursor). Također, ta akcija 

mi omogućuje da postojeći zid, ili sve ostale zidove, mogu rotirati u svim smjerovima u odnosu 

na tu ishodišnu točku.  

 

Slika 3. Opcija Ishodište na 3D pokazivaču (Origin to 3D Cursor) 
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Nakon odabira gornja dva segmenta, duplicirao sam jednom te nadodao ostatak zida 

jednostavnim naredbom Kopiraj (Duplicate (Shift+D)). Još jednim kopiranjem, kreirao sam i 

treći zid koji je identičan prethodnome. Također, uz zidove kopirana je i prva postojeća kula 

prilikom koje sam još dodatno dvije izradio. Nakon kreiranja sva tri zida i sve tri kule, uslijedio 

je proces namještanja svih elemenata u prvu konkretnu strukturu iz koje se već može naslutiti 

o kojoj se građevini radi.  

 

Slika 4. Grubi početni izgled utvrde 

 

Kako je prethodno bilo spomenuto, zidovi su kreirani u 3 segmenta. Drugi segment, 

odnosno srednji segment zida iskoristio sam kako bih napravio drveni dio konstrukcije Starog 

grada na kojem će kasnije biti nadodani prozori. Taj segment u odnosu na cigleni dio zida 

dodatno je izvučen prema van (i prema unutarnjem dijelu), dok će treći segment, odnosno gornji 

dio biti iskorišten za grubu izradu krovišta nad zidovima.  
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Slika 5. Modeliranje drvene konstrukcije na zidinama 

 

 

Slika 6. Modeliranje krovišta na zidinama 

 

Nakon izrade drvenog dijela konstrukcije i krovišta na jednom zidu, identičnu stvar sam 

napravio na preostala dva zida, te sam tako dobio izgled građevine koja svojim izgledom gotovo 

liči na utvrdu Staroga grada. Kako bih finalizirao grubi izgled utvrde bilo je potrebno završiti 

krovište nad kulama. Krovišta su specifičnog stožastog oblika te je postojalo nekoliko različitih 

načina da se isti izrade. Odabrao sam način sa kojim uzimam već postojeći oblik površine kule, 

te isti modeliram kako bih napravio stožac. Odabirom gornje površine kule, te zatim naredbom 
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Razdvoji -> Selekcija (Seperate -> Selection) odabrao sam samo gornju površinu kule, te 

naredbom Objekt -> Postavi ishodište -> Ishodište geometrije (Object -> Set origin -> Origin 

to Geometry) sam pričvrstio površinu za samu kulu kako bi prilikom modeliranja ta površina 

ostala dijelom te kule. Kružnu površinu sam povećao, da rubovi prelaze dijelom preko kule 

zatim sam naredbom Istisnuti (Extrude) napravio novi cilindar kojeg sam spojio u jednoj točci 

i tako dobio stožac. Što se tiče odnosa veličina, omjer kule i krovišta stošca je bio 2:1, odnosno 

cijela struktura kule podijeljena je na 3 dimenzijski slična dijela, od toga 2 dijela odlaze na 

samu strukturu kule, dok jedan dio je samo krovište.  

 

 

 

 

 

 

Slika 7. Modeliranje krovišta na kulama 

 

Izradu okolnog terena započeo sam kreiranjem površine preko naredbe Dodaj -> Oblik 

-> Ravnina (Add -> Mesh -> Plane). Novonastala površina kreirana je kao jedna cjelina zasebna 

te ju nije moguće dodano modelirati na način da joj se određeni dijelovi povise, snize ili da se 

drugačije postavi tekstura. Stoga je u toj situaciji potrebno istu površinu putem naredbe Podijeli 

(Subdivide) dodatno podijeliti na niz manjih površina.  
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Slika 8. Podjela površine 

 

Takvu površinu moguće je naknadno modelirati, mijenjati dimenzije, strukturu i oblik, 

a da pritom ne mijenjamo grube dimenzije kreirane površine. Također, moguće je površinu 

podijeliti na način da se ista dijeli samo u odnosu na određene osi koje želimo. Tako se određena 

površina može podijeliti samo na vertikalne linije ili samo na horizontalne linije, a sve u 

odnosno kako i na koji način želimo modelirati našu površinu. Kako bih dobio približan izgled 

terena oko i iza tvrđave Staroga grada, potrebno je bilo po X-osi modelirati površinu preko 

horizontalnih linija. Površinu sam podijelio na način da mi što bolje odgovara referenci, 

odnosno da je veći dio terena iza tvrđave s obzirom da mi je ista u prvom planu, što će se i 

vidjeti na završnom prikazu  
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Slika 9. Proces modeliranja okolnog terena 

 

Nakon zadovoljavajućeg izgleda gornjeg terena pristupio sam izradi korita rijeke. 

Označavanjem lijevog vanjskog ruba, zajedno sa svim podjelama površine te jednostavnim 

pomicanjem po Z-osi, i korigiranjem po X-osi i Y-osi dobio sam početnu dubinu korita rijeke 

Kupe.  
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Slika 10. Proces modeliranja obale i korita rijeke 

 

Daljnjim modeliranjem, odnosno kreiranjem novih površina na postojeće, te 

pomicanjem po željenim osima kreirao sam dno korita rijeke Kupe, te suprotnu stranu obale 

rijeke koju će mi služiti kao referenca za izradu vodene površine, odnosno rijeke, te koju ću 

uključiti po potrebi u finalnu statičku scenu i završni prikaz.  
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Slika 11. Završni izgled okolnog terena i korita rijeke 

 

Nakon grube izrade terena i konačnog izgleda korita rijeke, pristupio sam gruboj izradi 

vodene površine koja će mi predstavljati jedan od ključnih elemenata za finalnu scenu. 

Centralnu točku postavio sam u centar korita te kreirao običnu površinu koja je veličinom bila 

veća od same konture korita. Dodatnim pomicanjem točaka površine prilagodio sam izgled već 

postojećem obliku terena. To je napravljeno iz jednostavnog razloga što prilikom renderiranja 

finalne scene, ne renderira se samo onaj kadar što uhvati kamera, nego se renderiraju i sve 

okolne površine i teksture koje nisu uhvaćene kamerom. Stoga, ako postoji višak elemenata 

koji su izvan kadra i koji su ne iskoristivi, dodatno se povećava opterećenje računala i samo 

vrijeme renderiranja.  
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Slika 12. Početno modeliranje rijeke 

 

Postavljanje kamere i kuta gledanja posljednji je korak prilikom grubog postavljanja 

scene i prije modeliranja dodatnih detalja. Prema referentnoj slici postavio sam kameru otprilike 

na isto mjesto sa sličnim kutom gledanja. Tehničke karakteristike kamere prikazane su na slici 

ispod:  

 

 

Slika 13. Referentna slika za namještanje kamere i kuta gledanja 

 



15 

 

 

Slika 14. Karakteristike kamere za snimanje završne scene 

 

 

Slika 15. Izgled utvrde nakon početne faze modeliranja 
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4. Postavljanje osvjetljenja, te gruba izrada teksture terena 

i vode 

4.1. Osvjetljenje 

Kako bi finalna scena, odnosno završno renderiranje izgledalo besprijekorno potrebno 

je bilo dodati jedan od najvažnijih elemenata u programskom alatu Blender – osvjetljenje. 

Osvjetljenje kao izvor svjetla za konačni izgled završnog generiranja može se izraditi na 

nekoliko različitih načina. Ovisno o situaciji, izvor svjetla nam može biti od različitih izvora, 

od kućne lampe do sunca. Također, moguće je i namjestiti različite opcije emisije svjetla, broj 

odbijanja čestica svjetla i slični detalji koji pomažu i pospješuju finalno generiranje da bude što 

bolje. U ovom slučaju, za izvor svjetla iskoristio sam običnu površinu. Prilikom odabira opcije 

Materijali (Materials), dobio sam različite opcije za označenu površinu kojom mogu mijenjati 

namjenu. Tako odabirom opcije Površina (Surface), dobijemo listu različitih namjena, a 

odabirom Emisija (Emission) opcije zapravo površini dodajemo namjenu reflektiranja svjetla. 

Ostale opcije koje imamo su Boja (Color) za određivanje boje, te Jačina (Strength) koja nam 

služi za određivanje jačine svjetla.  

„Ključni čimbenik za dobivanje kvalitetnih vidljivih završnih generiranja je dobra 

osvijetljenost vaše scene. Ako je premalo osvjetljenja, vrlo je vjerojatno da će konačni prikaz 

izgledati tamno i jedva vidljiv, gubeći detalje i teksture.“ (Velasco, 21.4.2020.) 
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Slika 16. Opcija Materijali (Materials) prilikom kreiranja osvjetljenja 

 

 

Slika 17. Postavke nakon odabiranja opcije Emisija (Emission) 
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Slika 18. Grubi generirani prikaz osvjetljenja 

 

Kako bih dobio finalnu scenu dobro osvjetljenu potrebno je eliminirati sve sjene koje se 

stvaraju zbog svjetla. Tako dodatnim namještanjem dobio sam izvor svjetla koji želim, sa prave 

strane na način da mi je cijela tvrđava osvjetljena bez sjene.  

 

 

Slika 19. Položaj osvjetljenja nakon popravljanja 
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Slika 20. Završno osvjetljavanje 

 

4.2. Gruba tekstura terena 

Odabirom zemljanog terena oko tvrđave i samog korita rijeke pristupio sam gruboj 

izradi teksture terena. Opcijom Materijali (Materials) započeo sam kreiranje teksture. 

Otvaranjem opcije Materials dobijemo na izbor iznimno puno opcija koji se odnose na oblik, 

boju i sastav teksture. S obzirom da je cilj ovog završnog rada prikazati osnovne korake 

modeliranja u programskom alatu Blender, iskoristio sam samo nekoliko jednostavnih opcija. 

Bazna boja (Base color) je opcija koja nam označava baznu boju našeg terena, dok je opcija 

Grubost (Roughness) dodaje malo grubosti u samu teksturu. S obzirom da je riječ o zemlji, 

tamno smeđa boja za baznu boju se činila kao prikladnom, kao i veća vrijednost od zadane u 

opciji Grubost (Roughness). Također, prilikom testiranja svih opcija odličan i vrlo koristan je 

prikaz kugle koja predstavlja „jednu česticu“ teksture za površinu koju ste odabrali.  
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Slika 21. Postavke za početnu teksturu terena oko tvrđave 

 

 

Slika 22. Početni izgled terena oko tvrđave 
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4.3. Izgled i tekstura vode 

Odabirom prethodno kreirane površine vode krenuo sam u dodavanje detalja, da 

zapravo ta površina poprimi stvarniji izgled vode. Također, odabirom opcije Materijali 

(Materials) pridodao sam dodatnom i boljem izgledu vode. Nakon odabira površine, putem 

opcije Podijeli (Subdivide) istu sam podijelio na nekoliko manjih površina. Kako ne bih morao 

ručno odabirati točke, označenoj površini pridodao sam opciju Odaberi nasumično (Select 

Random) koja nasumično označava točke manjih površina koje smo dobili podjelom. Zatim, 

jednostavnim pomicanjem po Z-osi dobio sam manja izbočenja na samoj površini.  

 

Slika 23. Kreiranje izbočenja na vodi 

 

Otvaranjem opcije Kontekstni Izbornik Objekta (Object Context Menu), te odabirom 

opcije Izgladi (Shade Smooth) izgladio sam mala nasumična izbočenja na površini, te tako vrlo 

jednostavno dobio izgled manjih valova, odnosno kretanja rijeke.  
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Slika 24. Završni izgled površine vode 

 

5. Prva faza detaljnog modeliranja tvrđave 

Zadovoljavajućim izgledom grubog izgleda tvrđave, terena i vode krenuo sam u 

detaljnije modeliranje tvrđave. Prva faza se odnosi na dodavanje dodatnih baznih boja, 

unaprjeđenjem oblika postojećih elemenata te nadogradnjom dodatnih građevina i zidova. Za 

dodatne detalje koristio sam istu referentu fotografiju koja je vidljiva na prethodnim temama.  

5.1. Modeliranje spojnog zida i sekundarne građevine 

Pregledavanjem referentne fotografije, vidljivo je da pokraj tvrđave postoji dodatna 

građevina koju nisam htio izostaviti iz završne scene. Sekundarna građevina povezana je sa 

spojnim zidom na kojem se nalazi manji prolaz.  

Započeo sam dodavanjem kocke preko opcije Dodaj -> Oblik -> Kocka (Add->Mesh-

>Cube) te sam istu postavio uz sami rub kule od koje kreće zid i prema kojoj je izgrađena 

sekundarna građevina. Početak tog zida ostavio sam kao referencu nakon koje sam kasnije istu 

iskoristio za detaljno modeliranje.  
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Slika 25. Početak modeliranja spojnog zida 

 

Dodavanjem još jedne kocke započeo sam modeliranje sekundarne građevine. S 

obzirom da ta građevina nije u prvome planu, odlučio sam ne postavljati mnogo detalja na istu. 

Ostati će ugrubo modelirana sa teksturom u prikazu finalne statičke scene. Dodanu kocku 

modelirao sam da dobijem puni pravokutnik kojeg sam što je bolje moguće pozicionirao. Nakon 

toga, postojeću kocku za referencu pretvorio sam u grubi izgled spojnog zida sa sekundarnom 

građevinom.  

 

Slika 26. Početak modeliranja sekundarne građevine 
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Konačni grubi izgled sekundarne građevine dobio sam tako da sam puni pravokutnik 

podijelio na 4 jednaka dijela duž Y-osi te sam gornje vanjske točke spojio sa vanjskim srednjim 

točkama i dobio sljedeći izgled: 

 

Slika 27. Grubi izgled sekundarne građevine 

 

Kako bih dobio malo detaljniji pogled na dosadašnji proces modeliranja, krovištima na 

tvrđavi i krovištu na sekundarnoj građevini dodao sam boje po izboru.  

 

Slika 28. Početno dodavanje boja modeliranim elementima 
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Modeliranje spojnog zida i prolaza na istom započeo sam klasičnom podjelom putem 

opcije Podijeli (Subdivide). Bilo je potrebno kreirati nekoliko podjela kako bi sami prolaz bio 

što bolje napravljen i u nekoj prihvatljivoj razini detalja. Koristeći opcije skaliranja i podjela 

kreirao sam, od postojećeg elementa početnog zida, betonski stup i nadvoje. 

 

Slika 29. Modeliranje prolaza spojnog zida 

 

Zatim sam napravio prolaz u zidu na isti način, te sam naredbom Obriši -> Površinu 

(Delete->Faces) uklonio označene površine. 

 

 

 

 

 

 

Slika 30. Završno modeliranje prolaza na spojnome zidu 
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5.2. Modeliranje podnožja tvrđave i dodavanje baznih boja 

Kako bih izradio skošeno podnožje na kulama bilo je potrebno istu označiti i dodano 

podijeliti horizontalno prema Y-osi. Napravio sam nekoliko dodatnih podjela s obzirom da sam 

na početnom dijelu kosine izradio dodatni obruč. Pomicanjem točaka po osima kreirao sam 

spomenuto košenje i zadovoljavajući obruč.  

 

Slika 31. Modeliranje podnožja kule 

 

Identičnu stvar napravio sam i na ostalim kulama. Posljednji dio prve faze modeliranja 

detalja završio sam sa dodavanjem baznih boja na sve površine koje su mi ulazile u finalnu 

scenu. Nakon završetka, dobio sam ovaj izgled: 
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Slika 32. Prikaz dosadašnjeg procesa 

 

6. Druga faza detaljnog modeliranja tvrđave 

Druga faza detaljnog modeliranja tvrđave Starog grada Siska obuhvaća nekoliko 

elemenata. Prvi dio je dodavanje pozadinske slike u HD rezoluciji, zatim je uslijedilo grubo 

modeliranje prozora na kulama, izrada prozora na drvenoj konstrukciji tvrđave i izrada metalnih 

vratnica na prolazu. Uz postojeću sekundarnu građevinu, druga faza također obuhvaća 

modeliranje dodatne građevine te dvaju stepeništa od tvrđave do rijeke.   

6.1. Dodavanje pozadinske fotografije u HD rezoluciji 

Pozadinska slika omogućuje nam da izrađeni model smjestimo u neku određenu scenu 

te da iskoristimo elemente slike kao našu pozadinu. U ovom slučaju, pozadinska slika poslužila 

mi je da nadodam dio drveća, te da nadodam dio oblaka, odnosno neba kako bi završna scena 

bila što kvalitetnija. Proces dodavanja fotografije započeo sam otvaranjem Izbornik sjenčanja 

(Shader Editora) te prebacivanjem fokusa sa objekta na cjelokupni projekt. Zatim naredbom 

Tekstura -> Tekstura okoliša (Texture -> Environment Texture) otvorio sam prozor za 

dodavanje fotografije te isti spojio sa Vanjski Izgled (World Output) prozorom.  
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Slika 33. Prikaz postavke Teksture Okoliša (Environment Texture) 

 

Nakon toga, metodom Povuci i Ispusti (Drag And Drop) ubacio sam željenu sliku u 

Teksturu Okoliša (Environment Texture), te sam dobio željeni rezultat:  

 

 

Slika 34. Referentna fotografija u HD rezoluciji 
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Slika 35. Prikaz nakon ubacivanja fotografije u HD rezoluciji 

 

6.2. Grubo modeliranje prozora na tvrđavi 

Grubu izrada prozora na kulama tvrđave zamišljeno je napraviti na način da se kreira 

jedan grubi element koji će biti postavljen na mjesta gdje su otprilike prozori, te da se zatim 

izreže taj element iz kule prilikom čega će se stvoriti rupa, koja će kasnije poslužiti za detaljno 

modeliranje prozora.  

 

Slika 36. Grubi model potreban za izradu prozora na kulama 
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Jednostavnom naredbom Kopiraj Objekte (Duplicate Objects) postojeći oblik kopirao 

sam te namjestio na željena mjesta 

 

Slika 37. Postavljanje modela za izradu prozora na željena mjesta 

 

 

6.3. Izrada metalnih vratnica 

Metalna vrata u već postojećem prolazu spojnog zida započeo sam kreiranjem 

jednostavnog cilindra opcijom Dodaj -> Oblik -> Cilindar (Add -> Mesh -> Cylinder). Zatim 

sam taj objekt stavio na početak prolaza te sam iskoristio nekoliko opcija u postavkama Dodaj 

Modifikator -> Niz (Add Modifier->Array). Prva opcija koju sam iskoristio bila je Relativni 

Pomak (Relative offset) pomoću kojeg sam, u odnosu na početni objekt, odnosno prvi šipku, 

postavio vrijednosti koje se odnose na relativan razmak po X-osi i Y-osi. Nadalje, opcijom 

Pobroji (Count) sam zapravo samo nadodao broj ponavljanja i tako kreirao 12 vertikalnih šipki 

za početak.  
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Slika 38. Početak izrade metalnih vratnica 

 

 

Slika 39. Izgled Modifikatora za nizove za izradu metalnih vrata 

 

Dupliciranjem jedne od šipki te stanjivanjem promjera i rotiranjem kreirao sam dvije 

horizontalne šipke.  
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Slika 40. Postavljanje horizontalnih šipki na metalna vrata 

 

Zatim koristeći već dobro poznatu naredbu Izreži Oblik i Pomakni (Loop Cut and Slide 

(Ctrl + R)) na 5 šipki kreirao sam rezove koji su mi poslužili kao manja vrata koja se mogu 

otvoriti. U finalnoj sceni postavio sam ta manja vrata da ostanu otvorena.  

 

Slika 41. Završni izgled metalnih vrata 
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6.4. Izrada prozora na drvenoj konstrukciji krovišta 

Izradi prozora pristupio sam na način da sam kreirao kocku, koju sam modelirao na 

način da bude što sličnijeg oblika kao i prozor. Koristio sam sve već do sada poznate naredbe i 

pomicanja po osi. U opcijama Materijali (Materials) elementu sam nadodao bazne boje, te na 

staklenim dijelovima opciju Površina (Surface) sam stavio u Staklo (Glass BSDF) kako bi što 

bolje prikazalo staklenu površinu.  

 

Slika 42. Izgled prozora na drvenoj konstrukciji zida 

 

Nakon izrade prvog elementa i odabirom istog otvorio sam opciju Dodaj Modifikator 

(Add Modifier) te sa postojeće liste odabrao sam Niz (Array) pomoću koje sam kreirao ostatak 

prozora u nizu. Opcije koje su korištene identične su opcijama koje sam koristio pri izradi 

metalnih vrata. Taj niz kreiran je samo na jednom zidu, te dupliciran na ostale zidove.  
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Slika 43. Završni izgled prozora na drvenoj konstrukciji zida 

 

 

6.5. Modeliranje sekundarne kule 

Uz sekundarnu građevinu, tokom procesa modeliranja, odlučio sam kreirati još jednu 

građevinu koja bi predstavljala južnu sekundarnu kulu. Započeo sam klasičnim naredbama 

Dodaj -> Oblik -> Kocka (Add->Mesh->Cube), te sam kreirao bazni dio. Modeliranje ovog 

elementa ne razlikuje se od modeliranja prethodnih kula, jedino je vidljiva razlika na 

konstrukciji krovišta. Konstrukcija krovišta nije stožastog oblika kao na preostalim kulama, 

nego je kreirana kvadratna površina iz postojeće površine baznog dijela objekta. Ista je malo 

proširena, duplicirana te je gornja, novo duplicirana površina, smanjena u centru. Pomoću 

naredbe Istisni Predio i Pomakni (Extrude Region and Move), te pomicanjem po Z-osi dobio 

sam željeni izgled krovišta.  
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Slika 44. Modeliranje sekundarne kule 

 

Dodavanjem bazne boje završio sam proces modeliranja sekundarne kule.  

 

Slika 45. Prikaz sa modeliranom sekundarnom kulom 

 

6.6. Modeliranje dvaju stepeništa prema rijeci 

Prije samog modeliranja stepeništa, na zapadnom zidu utvrde bilo je potrebno napraviti 

manja zatvorena vrata, istog oblika kao i prolaz u spojnome zidu prethodno izrađen. S obzirom 

da su oblik i dimenzije približno jednaki, jednostavnim dupliciranjem linija kopirao sam 

postojeći izrez i postavio ih na željeno mjestu na zidu, te sam nadodao baznu boju radi lakšeg 

prepoznavanja.  

Prvo stepenište koje sam započeo bilo je na istom mjestu kao i prethodno modelirana 

vrata. Započeo sam izradu tako da sam iz zemljanog terena izvukao linije pomoću naredbe 
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Izreži Oblik i Pomakni (Loop Cut and Slide), te sam tako dobio željenu konturu. Nakon toga, 

naredbom Razdvoji -> Selekcija (Seperate->Selection) izdvojio sam konturu iz ostatka terena 

i tako kreirao zasebni element preko kojeg mogu nastaviti modelirati stubište.  

 

Slika 46. Prikaz sa izdvojenom početnom konturom stepeništa 

 

S obzirom da mi je postojeća kontura sada kao zasebni element jednostavnim 

naredbama Izreži Oblik i Pomakni (Loop Cut and Slide) i Istisni Predio i pomakni (Extrude 

region and move) kreirao sam rubnjake te tako dobio novi oblik stepeništa.  

 

Slika 47. Prikaz rubnjaka na stepeništu 
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Identičnim postupcima kreirao sam i drugo stubište koje se spajalo od spojnog zida i 

metalnih vrata prema rijeci. Finalni izgled početne konture obaju stubišta prikazano je na slici 

ispod.  

 

Slika 48. Modeliranje drugog stepeništa 

 

Putem naredbe Dodaj -> Oblik -> Kocka (Add->Mesh->Cube) započeo sam kreiranje 

prve stepenice koju sam naknadno modelirao i poravnao prema referentnim fotografijama. 

Nakon što sam istu oblikovao i namjestio, putem naredbe Dodaj Modifikator -> Niz (Add 

Modifier->Array) istu sam duplicirao u niz preko opcija Relativni Pomak (Relative Offset) i 

Pobroji (Count), a za putanju niza stepenica ručno sam namjestio te iskoristio sam već kreiranu 

konturu stepeništa.  
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Slika 49. Proces modeliranja stepeništa 

 

U cijelom procesu izrade prvih stepenica bilo je iznimno puno ručnog namještanja, 

skraćivanja, dodatnih popravaka i prepravaka kako bi iste izgledale besprijekorno te kako ne bi 

izlazile iz dodatnih kontura. Finalni izgled prvih stepeništa prikazano je na sljedećoj slici. 

 

Slika 50. Završni izgled stepeništa 

 

Nadalje, drugo stepenište je bilo daleko lakše za modelirati s obzirom da sam uvažio 

sve pogreške i krive postupke tokom modeliranja prvih stepeništa. Nije bilo mogućnosti 
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dupliciranja jednostavno niza stepenica s obzirom da sam nenamjerno napravio konturu 

različite širine. Stoga potpuni proces izrade stepeništa morao sam ponoviti. Završni izgled obaju 

stepeništa prikazan je na sljedećoj slici.  

 

Slika 51. Izgled 3D modela nakon završetka stepeništa 

 

7. Završno modeliranje i postavljanje teksture 

Završno modeliranje tvrđave odnosi se na završetak prozora na obje kule, postavljanje 

novih prozora na sekundarnu zgradu te modeliranje manjih elemenata poput dimnjaka na 

krovištu tvrđave. Postavljanje završne teksture odnosi se na kompletan završni dio u kojem se 

na svim površinama postavlja različita tekstura kako bi svi modeli što kvalitetnije izgledali. Na 

kraju cijelog procesa postavljanja teksture, završnim modeliranjem postavio sam 3D modele 

drveća na prostor oko tvrđave.  

7.1. Završno modeliranje prozora 

Uz modeliranje stepeništa, završno modeliranje prozora definitivno je bio najzahtjevniji 

dio ovog završnog rada. Sam postupak u principu je jednostavan, no kako bih postigao efekt 

prozora kojeg mogu pronaći na referentnim fotografijama bilo je potrebno malo više se 

potruditi, namjestiti i dodatno modelirati neke dijelove.  

S obzirom da sam grubu izradu prozora modelirao samo na jednoj kuli, bilo je potrebno 

izraditi iste i dodatne modele na drugoj kuli. Tako sam od postojećih modela sa prve kule 
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duplicirao modele te ih prebacio na drugu kulu. Prilikom toga, izradio sam i nekoliko novih 

modela prozora. Prilikom izrade novih grubih modela prozora koristio sam već postojeće 

naredbe Izreži Oblik i Pomakni (Loop Cut and Slide), te Pomakni (Move). Novi model 

duplicirao sam nekoliko puta, te postavio na željena mjesta.  

 

Slika 52. Izgled novog modela prozora 

 

Prije negoli sam od postojećih izbočenja napravio rupe koje predstavljaju prozore, na 

svakoj kuli zasebno sam selektirao sva izbočenja i napravio ih zajedničkim elementom, tako da 

koje god opcije da sam htio promijeniti, promijenio bih na svim prozorima jednako. Umjesto 

desetak elemenata, prenamijenio sam iste u samo dva zasebna elementa. Označavanjem prve 

kule (samo baze, bez izbočenja) pristupio sam naredbi Dodaj Modifikator -> Boolean (Add 

Modifier -> Boolean). Modifikator Boolean (Boolean Modifier) služi nam kako bi na 

kompleksnim površinama, oduzeli objekte jedan od drugoga. U ovom slučaju, kocke koje 

predstavljaju izbočenja sam htio oduzeti od površine cilindra odnosno kule.  

„Boolean modifikator izvodi operacije na objektima koje su inače suviše složene da bi se 

postigle sa samo nekoliko koraka ručnim uređivanjem. Koristi jednu od tri dostupne logičke 

operacije za stvaranje jednog objekta od dva objekta“ (Boolean Modifier – Blender, 

docs.blender.org) 
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Slika 53. Izgled Boolean modifikatora 

 

Sam Boolean Modifikator (Boolean modifier) nema puno opcija, no međutim ono što 

predstavlja bitno olakšava rad sa dva ili više objekta koji su u međusobnom odnosu. Putem 

opcije Objekt (Object) odabran je prvi element izbočenja. Opcijom Razlika (Difference) 

postižemo da se izbočenja oduzmu od postojeće kule kreirajući tako rupe za prozore. Rupe je 

bilo potrebno dodatno modelirati, proširiti, povećati te postaviti stražnju površinu pošto nisam 

htio da rupa kao takva ostane šuplja. Nakon završenog modeliranja finalni izgled kule sa 

prozorima prikazan je na sljedećoj slici. 

 

Slika 54. Završni izgled kule sa prozorima 
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Nakon što sam identičnu stvar napravio i na drugoj kuli, napravio sam završno 

modeliranje prozora na sekundarnoj građevini. Taj proces je bio jednostavan i brz s obzirom da 

sam iskoristio već postojeći model prozora sa drvene konstrukcije. Bilo je potrebno prilagoditi 

veličinu i poziciju prozora konstrukciji građevine i naredbom Dodaj Modifikator -> Niz (Add 

Modifier->Array) kreirao sam niz prozora na građevini. Već spomenutim opcijama Relativni 

Pomak (Relative Offset) i Pobroji (Count) kreirao sam željeni broj prozora i njihov međusobni 

razmak.  

 

Slika 55. Završni izgled sekundarne građevine sa prozorima 

 

7.2. Postavljanje teksture  

Govoreći o teksturama u programskom alatu Blender možemo reći da pomoću njih 

dobivamo izgled i strukturu našeg objekta kojeg modeliramo. One su vizualni predstavnik 

našeg objekta, odnosno daju mu dodatan detalj i informaciju o kakvoj se strukturi radi, odnosno 

od kojeg materijala je izrađen naš objekt. 

Označavanjem prve kule pristupio sam završnom dijelu dodavanja teksture na sve 

površine 3D modela utvrde Stari grad Sisak. Putem Izbornika Sjenčanja (Shader Editora) 

otvorio sam Tekstura Slike (Image Texture) prozor preko kojeg sam željenu sliku postavio kao 

teksturu zida prve kule. Opcijom Otvori (Open) odabrao sam željenu sliku cigle te spojio opcije 

Boja (Color) sa opcijom Bazna boja (Base color).  
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Slika 56. Izgled teksture za zidove utvrde 

 

 

Slika 57. Početni izgled modela nakon dodavanja teksture 

 

Prilikom toga, učitana slika cigle je daleko veća nego model koji je izrađen stoga je 

razmjer dijelova slike i modela bio jako različit, te nisam dobio željeni efekt. Kako bi smanjio 

odnos između učitane slike cigle i zida kule iskoristio sam UV Izbornik (UV Editor). Isti nam 

služi kako bi 2D sliku vrlo lako mapirali na 3D objekt te postavili njihov odnos.  
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Označavanjem slike cigle i zida prve kule dobio sam njihov međusobni odnos. 

Jednostavnim skaliranjem dobio sam odnos koji sam htio, odnosno da je 3D model tvrđave 

daleko veći nego slika cigle. S time sam dobio željeni efekt na svim zidovima tvrđave. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 58. Skaliranje modela u odnosu na sliku teksture 
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Slika 59. Željeni izgled modela i teksture nakon UV Izbornika 

 

Identični proces nastavio sam raditi u UV Izborniku (UV editoru) selektirajući samo 

različite površine, odnosno različite zidove.  

 

Slika 60. Željeni izgled modela i teksture zidova tvrđave 

 

Isti proces napravio sam za sve ostale površine, učitavajući željene slike te koristeći UV 

Izbornik za namještanje njihovog odnosa: Krovišta na kulama i zidovima između kula, drvenoj 

konstrukciji, sekundarnim građevinama te okolnom terenu.   
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Slika 61. Tekstura krovišta 

 

 

Slika 62. Tekstura drvene konstrukcije 

 

 

Slika 63. Tekstura krovišta sekundarne građevine 
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Slika 64. Tekstura trave  

 

 

Slika 65. Tekstura betonskih ploča  

 

 

Slika 66. Završna scena nakon postavljanja teksture  
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7.3. Postavljanje drveća na okolni teren 

Na samome kraju izrade 3D modela tvrđave Stari grad Sisak pristupio sam dodavanju 

novih 3D objekata drveća kako bih upotpunio praznine i između ostalog obuhvatio sve dijelove 

sa referentne slike. Ubacivanje 3D modela drveća ostvario sam putem opcije Datoteka -> 

Dodaj… (File -> Append….) Putem interneta istražio sam o različitim modelima drveća te sam 

nekoliko 3D modela besplatno preuzeo sa stranice www.free3D.com gdje sam preuzeo zbir od 

3 različita modela drveća koja sam preko gornje navedene opcije ubacio jednog po jednog.  

 

Slika 67. Dodavanje 3D modela drveta modelu tvrđave 

 

Daljnji proces sadržavao je ponavljanje istog procesa te slobodu postavljanja drveća na 

željena mjesta. Nekoliko puta bilo je potrebno malo prilagoditi veličinu, ali bitnijih promjena 

nije bilo.  

http://www.free3d.com/
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Slika 68. Završni pogled nakon dodavanja drveća 

 

 

7.4. Završno generirana statička scena 

 

Slika 69. Završno generirana statička scena utvrde Starog grada Siska 

 

 



50 

 

8. Uvoz 3D modela u platformu za izradu računalnih igara 

Kako bih kompletirao izradu 3D modela, osim samog prikaza, htio sam nadodati još i 

dio koji govori o funkcionalnosti samog 3D modela. Naime, u velikoj većini Blender usko 

surađuje sa raznim platformama za izradu računalnih igara, stoga krajnji ishod završnog rada 

sastoji se od izvoza 3D modela iz programskog alata Blender, te uvoz istog u platformu za 

izradu računalnih igara. Za platformu odabrao sam jednu od najčešće korištenih platformi – 

Unity.  

„Kao platforma za izradu igara, Unity je u mogućnosti pružiti mnoge najvažnije 

ugrađene značajke zbog kojih igra funkcionira. To znači stvari poput fizike, 3D prikazivanja i 

otkrivanja sudara. Iz perspektive programera, to znači da nema potrebe za ponovnim 

izmišljanjem kotača.„(Sinicki, 23.6.2020.) 

 Prvo korak koji je bilo potrebno učiniti jest instalirati verziju Unity-a. Isti se može 

preuzeti sa njihove matične stranice, te nakon instalacije i potrebne prijave preko Google 

računa platforma se može pokrenuti. Prilikom otvaranja otvara se Unity Hub koji služi kao 

baza vaših projekata. U istome je moguće pregledavati projekte, te iste otvarati ili micati 

prema vlastitim željama.  

 

 

Slika 70. Prikaz Unity Hub prozora 

 

Klikom na opciju Novi (New) otvara nam se drugi prozor koji nam služi za stvaranje 

novog projekta. Ovisno o vlastitim željama i projektu, postoji nekoliko različitih mogućnosti 
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koji projekt želite otvoriti. S obzirom da imam 3D model, otvorio sam jednostavan 3D projekt. 

Uz odabir vrste projekta, moguće je promijeniti lokaciju gdje će se isti kreirati, te također 

moguće je promijeniti i ime.  

 

Slika 71. Kreiranje novog projekta 

 

Klikom na Kreiraj (Create) kreirali smo novi Unity projekt u koji ćemo ubaciti naš 

model. Za početnika, prvi dojam o korisničkom sučelju će biti zaista iznenađujući s obzirom da 

se nalazimo u jednoj od najjačih platformi za izradu igara. Vrlo jednostavno sučelje definitivno 

daje dojam jednostavnosti korištenja platforme i zasigurno povećava motivaciju za daljnji rad.  

  

Slika 72. Prikaz korisničkog sučelja 
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Uvoz 3D modela je u principu vrlo jednostavan, te nema kompliciranih naredbi i ne 

zahtjeva neko specijalno znanje. Klikom na padajući izbornik Resursi (Assets) odabiremo 

opciju Uvezi Novi Resurs (Import New Asset…) gdje nakon toga odabiremo naš 3D model 

izvezen iz Blendera.  

 

Slika 73. Prikaz uvoza novih resursa 

  

 Nakon određenog vremena 3D model kompletno je uvezen u platformu za izradu igara 

Unity. Ono što je bitno naglasiti, model je uvezen sa baznim bojama te ne sadrži teksturu koja 

je prethodno napravljena u programskom alatu Blender. Model se neće odmah prikazati nego 

je potrebno iz prozora Resursi (Assets) akcijom Povuci i Ispusti (Drag and Drop) prenesti 

model u gornje prikazanu praznu scenu. Također, klikom na datoteku unutar prozora Resursi 

(Assets) dobijemo prikaz svih pojedinačnih elemenata koji su rađeni u programskom alatu 

Blender.  
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Slika 74. Prikaz nakon uvoza 3D modela 

 

Nakon kratkog namještanja pogleda i kamere, završni pogled prikazan je na sljedećoj 

slici.  

 

Slika 75. Završni prikaz nakon uvoza 3D modela 
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9. Zaključak 

 Praktični dio rada izrađen je prije samog pisanja završnog rada. Prilikom toga, prva 

ideja je testirana nekoliko puta, a uključivala je izradu 3D modela i animacija. S obzirom da 

sam bio svjestan situacije da bilo kakve animacije oduzimaju veliki dio vremena, a i resursa 

računala, bio sam primoran odustati od te ideje pošto sam shvatio na samome početku da postoji 

mogućnost da mi sama izrada rada ne uspije. S obzirom da sam početku pretpostavku dokazao 

konkretnim primjerom, odlučio sam se za jednostavniji pristup te izradu statičnog modela i 

statične scene.  

  

 Kako je i u uvodu opisano, ideja je da se za izradu modela koriste jednostavne metode 

i jednostavni geometrijski oblici. Ideju sam u potpunosti ostvario s obzirom da sam za 

modeliranje cijelog 3D modela koristio isključivo najjednostavnije elemente poput kocke, 

cilindra i stošca. Izbjegavao sam korištenje kompleksnih postavki i opcija, iako bi nedvojbeno 

kvaliteta 3D modela bila još bolja. Ostao sam pri ideji da 3D model bude jednostavan, te da isti 

mogu shvatiti početnici.  

 

 Samo modeliranje nije stvaralo probleme niti oduzimalo vrijeme, iako se u nekim 

segmentima trebalo daleko više potruditi nego na ostalim elementima 3D modela. Prilikom 

modeliranja koristio sam nekoliko referentnih fotografija, dok mi je za odabir statične scene 

zapravo bila dovoljno samo jedna iz koje mi je u ideji bilo da 2D prikaz fotografije pretvorim 

u 3D scenski prikaz. S obzirom na priloženi model, mislim da sam u tome i uspio.  

 

 Izradom ovog 3D modela definitivno sam potvrdio da i početnici mogu izraditi 

kvalitetne 3D modele koristeći jednostavne metode, te sam potvrdio da je programski alat 

Blender stvarno izvrstan alat za ulazak na tržište i industriju video igara.  
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